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Executive Summary

The main goal of Work Package 3 is to both plan and execute a training program that
provides knowledge about adoption and deployment of open source software within EU
projects. It will also provide the material needed to do this training on points of technology,
legal aspects, and business models. It will support the WP2 online platform that hosts Open
Source artifacts of EU projects. To complement the technical information regarding features
and use, two documents are created: D2.2 acts as the Platform Handbook, and this
deliverable, D3.1, is an easily approachable quick start guide to the platform. D3.1 focuses
particularly on the most common work-flows that will be available from the launch. It deals
directly with creating projects, repositories and managing them through tickets and community
interaction. This FLOSS developer handbook serves also as an initial training material for the
communication and dissemination efforts and the possibility of turning the actual content into
a printed format will be explored. The WP 3 deliverables act as a core for the material used in
key dissemination activities carried out in Work Package 4.

The Platform is accessible at the following address: http.//opensourceprojects.eu/
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1. Introduction

One of the main strategies for PROSE to promote FLOSS within the ICT community is
defined as providing a platform where projects can develop FLOSS as well as establish a
community. In this process, the platform plays a decisive role, both as an internal tool for
projects to organize their development, and as an external tool, enabling community
engagement on the software being produced as part of the research results executed in
projects.

In deliverable D2.2. we provided the platform users with a user manual for the platform at
opensourceprojects.eu. To complement the technical information regarding features and
use, it is also beneficial to the PROSE audience to get a quick start guide on how to get
started creating projects on the platform and interacting with the FLOSS community. This is
done in the deliverable 3.1 that you are currently holding. It focuses particularly on the most
common work-flows that will be available from the launch. They deal directly with creating
projects, repositories and managing them through tickets and community interaction. This
FLOSS developer handbook serves also as an initial training material for the communication
and dissemination efforts and the possibility of turning the actual content into a printed format
will be explored.

In this document we provide an overview of the platform's main features and does so through
a brief guide on the key features of the platform. (Sec. 2). It does not try to be a
comprehensive look, that was done with the D2.2 — Platform handbook, rather it is targeted
for the developers and project managers starting up a project on the platform and provide
them with a shorter version of the key functionalities of the platform to get them started. The
contents of this document, alongside those of Deliverable D3.2 — Licenses explained, and
D3.3 FLOSS Business Models, will provide the material used in the training concept, that will
be realized further on in the project.
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2. Developer Handbook for PROSE Platform

This handbook will give you a look into how to get started with the PROSE platform. It will
introduce the most important aspects of the platform. For more detailed information on the
features of the platform you can find from the platform user manual, available from
http://www.ict-prose.eu or from the platform itself at http://opensourceprojects.eu.

Please also have a look on the platform itself. Under Documentation you can find some quick
start guides as well as other useful information.

All of the information is based on the current snapshot of the platform, available at
http://opensourceprojects.eu.

2.1. Setting up an account

Starting to use the platform requires a user account. You can create one from the front page.
Fill in your preferred display name, user name and email address. You will soon receive an
email with activation link and your password. Activate your account by clicking the link and
following the instructions given. Now you can start working on the platform.

Most, if not all, features are accessed through the left side login menu. This manual shows
the side menu also on the left side, so you can keep track on where you are going.

To login with your existing account, click the top left corner login-link and insert your
username and password. You can You can also associate an openlD to your account to ease
the log in process. Select your provider from the drop down menu and insert your username.
You will be then prompted to a login screen.
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2.2. User Management

Manage

Create, costumise and
monitor projects;
Admin tools

Wiki >
Tickets

Discussion

Git 3 »
Documentation »
Metadata

Screenshots

Categorization

Tools

User Permissions

Audit Trail
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User Management is the section of platform meant exclusive
for users to manage their User Management is the section of
platform meant exclusive for users to manage their account
settings and personal information. It provides the standard
tools to allow users to change their account and profile settings
and their personal data. This chapter helps you to get
comfortable with the User Management aspects of the
platform.

Choosing PROFILE from the top bar menu you get to see your
newly created public profile. It shows your projects, personal
data you have entered, skills, and email address you logged in
with.

You can change these details selecting Admin option from the
left side menu, as shown on the left. Initially you will have
limited selection of options, but the options increase when you
start up a project. More on that later.

The user profile handles all user related information and
explains how it is handled. User information can be configured
like any other project in the platform. The default tools available
to you, as mentioned before, are: Profile, Wiki and Admin.
These tools allow you to manage your information and the
visibility of that information.

2.2.1.User Settings

You can change your profile’s settings from the SETTINGS — option on top menu. On the
User Settings page you, the user, are able to set or change several personal details. A part on
this page is reserved for user contact details, like email, Skype, and social media contacts.
You can also give the URL to your personal website, if you have one.

On the more critical identification data, you are only allowed to change the display nhame and
password and set or change the primary email address associated to the account.
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Personal Settings

SEnaes Unknown ¥

Birth date:

Use the format DD/MM/YYYY

Country of residence: bk

City of residence:

Timezone:
— Unknown —

Save

Personal Contacts
Skype account:

Save

Add a social network account

Social network: Facebook T

Account url:

Save

Add a telephone number
New telephone number.

Save

Add a personal website
New website url:

Save

Change Password
Old Password:

New Password:

Figure 1: Part of User Settings form

The user settings page also gives you a single-page to manage your subscriptions. These are
the items for which the platform will send you an email notification when an update happens.
You are automatically subscribed only to your own wiki by default, but can follow other
applications as well. An example of this is in Figure 2. In this screen you can select each
subscription item by pressing the corresponding check box and hitting the save button.
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Authorized Third-party Applications

Mo authorized third-party applications

Subscriptions

Mark tools that you want to subscribe to. Unmark tools that you want to unsubscribe from. Press 'Save' button.

Project App Toplc Type Frequency Artifact

New project activity No subscription

New project admin No subscription

New project blog direct day All artifacts L
New project code direct day All artifacts v
New project code-0 direct day All artifacts v
New project discussion No subscription

New project link direct day All artifacts L4
New project search No subscription

New project tickets direct day All artifacts el
MNew project wiki direct day All artifacts <
Wandreia activity No subscription

wandrela admin No subscription

wandrela profile No subscription

wandrela search No subscription

Wandreia wiki direct day All artifacts i
Save

Figure 2: Subscriptions

2.2.2.Admin

The Admin menu option gives you the options to a set of sub-features, such as user's
metadata, tools, third-party users' permissions and audit trail, and is managed in a similar way
to any available project.

The main options available are:
* Metadata: Allows the user to change User Profile page title and icon.

* Tools: For the user to add any available tool (external links, code repositories, blog,
etc.) to their own account.

» User Permissions: Where the user may set new permissions of third-party users.

* Audit Trail: Displays a list of account management activity.

For more information, please consult the platform user manual.
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2.2.3.Wiki

There is another feature on the User Profile section of the platform, which allows the user to
create one or more wikis with multiple pages. It is accessed

On the wiki you can store documentation about your profile or any information that can be
shared, either public or private, depending on the defined permissions. The Wiki can also be
used to store tutorials, or any other miscellaneous information you have created or other
information relevant to a specific set of people, or even fully private available only to you.

Creating a wiki is similar to both the user and the project, so it is handled in the
communications section of this handbook in more detail. You can also get on-line instructions
from the platform’s Documentation section.

Profile R u/andreia

Admin > l

© Create Page Home P4 m aQ
Browse Pages Authors L.

Browse Labels

[ ErGige—————] This is the personal project of Andreia Palma. This project is created automatically during user registration as an easy place to

store personal data that doesn't need its own project such as cloned repositories.
Formatting Help

Andreia

Q Preview Formatting Help

Post Cancel Add attachment

Figure 3: Profile Wiki form

2.2.4. Creating a project

The most important part of the management tools is the actual project creation process. It can
be accessed from the top menu under PROJECTS. This opens a list of projects available to
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you. To create one of your own, select the + Add a Project from the left side menu.

This opens you a project creation interface as visible in Figure 4.

Projects
Create a Project

Project Name | New project

URL Name | newproject

http:/lopensource projects.eu/pinewproject

#| Private? Private projects will be unreadable to non-project members and will not show up in search
results.

¥ SVN

< > Enterprise-class centralized version control for the masses.

#| Tickets

@ Bugs, enhancements, tasks, etc., will help you plan and manage your development.

v Git

< > Git is a distributed version control system designed to handle everything from small to very large projects

with speed and efficiency.

o Wiki

Documentation is key to your project and the wiki tool helps make it easy for anyone to contribute.

Figure 4: Creating new project

Type in the new Project Name and "URL Name" (3-15 characters long, using only letters,
numbers, and dashes). This name will determine the project's base URL.

NOTE: Take care in selecting the name, as the URL is not easily changed!

Then select the services that will be initially enabled. You can add or delete services at any
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time. You can also select your project to be private by ticking the Private? box.

When you create a new project, you automatically are given administrator rights for that
particular project. After creating a new project, you will be brought to the project's "Metadata"
page, which may be accessed at any time. Here you can add in all the metadata relevant to
your project.

More options in this category include:
» Screenshots allows for adding screenshots and captions of the project.
» Categorization influences how the platform indexes the project.
* Tools provide a very flexible approach allowing projects to turn on or off the features
that are more relevant to each effort.
* User Permissions determine the capabilities of each user on the platform.

* Audit Trail displays a list of project activity.

They are handled in more detail in the platform handbook.

2.2.5.Creating a sub-project

Sub projects are a common part of large projects that require maintaining several tools and
source code under a common group, such as an ICT project. You can create sub-projects
under the Tools — selection.

You will be given two choices to create a sub-project: associate a sibling project or create a
new project as sub-project of the main one.

To achieve either of available options, it is necessary to navigate to the main project's tools
page
Login > Projects > ProjectName > Admin > Tools

and click to add a new Subproject tool. A form will pop up for you to fill in the sub-project's
information, such as its Label and its Mount Point. The platform checks if the mount point
already exists and either associates the existing point as the main one, or creates a new
project with the specified title in Label and URL name. This information is saved with the save
button.
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After the pop-up window is dismissed, the new Subproject tool will be listed along with the
other installed tools.

2.2.6. Adding users to the project

User permissions are an important part of the platform. They determine the capabilities of
each user on the platform and allow defining the visibility and scope of individual projects. It
also allows creating private projects to either specific users or groups of users.

It is possible to manage individual permissions regarding projects, either by managing single
users or by adding groups of users, from the User Permissions administration screen.

Projects > ProjectName > Admin > User Permissions

To add a user to a group, select "+ Add" under the appropriate group and enter their
username. Note that this is the unique username, not a display name.

To remove a user, select the "-" (minus) next to their username and confirm removal, as
identified in Figure 5.

The default groups users can be grouped into are:

* Admin: Project administrators have full control over the projects, and can add/remove
other members

* Developer: Most tools will allow Developers to perform most non-admin functions by
default.

* Members: Generally they have fewer permissions by default.
» *Authenticated: Any user signed into OpenSourceProjects.eu.

*  *Anonymous: Everyone, regardless of whether they are logged in or out.

A user with Admin rights belongs to all groups with lesser rights. This is also true with
Developer and Member groups.

You can also add your own custom groups with customized rights. Also the rights within each
individual tool can be customized group specifically. For more information on individual rights,
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consult the Platform Handbook.
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User Permissions
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Code
Tickets Project permissions are assigned to groups of users. Add users to a group appropriate to the role they fill in your project. more...
Wiki Group Users Permissions
Discussion v read
Blog @ Andreia Palma (andreia) v admin
Link Name s, samin © Add ¥, [atd
v update
Metadata
Screenshots e
Categrization All users in Admin group X admin
Toals A8 peveloper @ Add B —
User Permissions X update
Audit Trail
v read
All users in Developer group X admin
L'i Member © Add x iceats
X update
v read
X admin
B Authenticated Any logged in user X create
X update
v read
X admin
a Anonymous Any user including those not logged in X create
X update

@ Add a new group

Figure 5: User permissions page
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2.3. Code management

An important part of any forge platform is the actual source code

DEVEIDP management.

Support multiple tools for the

same project: As of now, there are two supported technologies for source code

Git and SVN management on the platform:
Wiki ’ | Gitand SVN
Tickets >
Discussion

They are supported by adding the corresponding tool, and can
support multiple tools for the same project. Therefore it is
possible to have more than one GIT repository for a project, or
even concurrent GIT and SVN repositories.

Admin
Documentation

Browse Commits
2 Fork Before we start, it should be noted that internally the platform
does not maintain any synchronization between repositories of
the same project and they are handled completely independent
master E of each other, therefore adding a GIT and an SVN repository will
corresponding to two entirely different source code trees.

2.3.1.GIT

GIT is enabled as a project tool, as already mentioned. Once added, a new Code entry will
appear on the project:

Projects > ProjectName > Code

After creating a new project, you can choose the needed tools for that project. For Source
Code Management (SCM), when both Git and SVN are chosen, GIT is defined as the default
when selecting the Code entry.
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Git is a SCM, a tool for software developers which supports collaborative development of
software within a team, and the tracking of changes to software source code over time.

Git is used by developers, and advanced users who need the very latest changes to the
software (before releases occur). Software users generally do not need Git; typically they will
download official file releases made available by the project instead.

Developers should familiarize themselves with Git by reading the Git Documentation or
traversing through a Git tutorial.

2.3.1.1. Using the GIT repository

The standard way to modify the contents of your repository is using a Git client as detailed in
the Git User's Manual. If the code repository is empty, the code browser will display some
instructions to help make the first commit and push, such as:

cd myproject

git init

# add all your files. Use can use specific filenames or directories instead of '.'
git add .

git commit -a -m 'Initial commit'

git remote add origin http://user@opensourceprojects.eu/git/p/newproject/code-0
git push origin master

git branch --set-upstream master origin/master # so 'git pull' will work later

If using Git with an existing repository:

cd myproject
git remote add origin http://user@opensourceprojects.eu/git/p/newproject/code-0
git push origin master

git branch --set-upstream master origin/master # so 'git pull' will work later

We strongly recommend that when modifying a repository, other committers be notified of the
direct edit window and that you make your own backups prior to editing the content so you
can restore it readily yourself in the case of an accident.
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To manage the Git tool, go to Tools page under
Projects > ProjectName > Tools > Code

and choose an option within the available from Git tool's block. It allows the administrators to
set visible files, refresh the repository, set user permissions, set new label or delete tool as
visible in figure below.

Code

<

Viewable Files
Refresh Repository
Permissions

Label

Delete

Figure 6: Git tool's block

2.3.2.SVN

Depending on the current tool configuration when adding an SVN repository it may be
available on the Code tab or at the selected name for the tool.

Apache Subversion is a software version and revision control system distributed under an
open source license. It allows users to maintain current and historical versions their project
files.

To use an existing project it is only necessary to checkout the source code. A command line
example is:
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svn checkout --username=user http://opensourceprojects.eu/svn/p/project/code/trunk project-code

To import an already existing source code.

cd existing-helloworld-code

svn import http://opensourceprojects.eu/svn/p/project/code/ -m "Initial commit"

2.3.2.1. Management

Login > Projects > ProjectName > Tools > Code

To manage the SVN tool, go to Tools page under

Projects > ProjectName > Tools > Code

and choose an option within the available from SVN tool's block. It allows to checkout URL,
import repository, set visible files, refresh the repository, set user permissions, set new label
or delete tool as depicted in Figure 7.

Code

<O

Checkout URL
Import Repo
Viewable Files
Refresh Repository
Permissions

Label

Delete

Figure 7: SVN tool's block
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2.4. Issue management - Tickets

Track

What needs to be
completed, bugs, requests
or tasks:

Tickets

Wiki >

Discussion

Git 3>

Admin ’

Documentation »
Create Ticket

Edit Milestones

View Statistics

Milestone

1.0 75
Changes 39
Closed Tickets kT
Open Tickets 38

Farmatting Help

2.4.1.Ticket - tool

Issue management is available on the platform as one of the
more important tools. It directly supports the development
process and tickets allow the users and developers to interact
with the project maintainers and main developers. In this section
you get a rough overview of how tickets are configured in a
specific project and how end-users can take advantage of them.

Tickets are specific items that correspond to problems identified
in the software, missing features requested by end users, or
general communication items between developers and users. In
many tools they are also known as “issues” or “bugs”, and hence
the name of issue or bug trackers.

The ticket tracker tool is designed to allow for flexibility in how
you track items of work that need to be completed. This includes
bugs, feature requests from end users, or any other task you
want to keep track of. You can even install multiple ticket
trackers for different purposes. For example, a large project
could have individual trackers for the design team, the
documentation team, the developers, and another for support.
Each of these trackers can have their own unique list of tickets,
as well as custom fields, custom milestones, and their own
"mailing list." Tickets can even be moved between tickets
instances, even if they're on different projects.

You may install a ticket tracker via Tools page and by clicking Tickets to get to a tool form.
Follow the instructions on screen, simply add the Ticket tool with the appropriate label and

mount point.
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After creating an instance of the Tickets tool, the project tools page may look like Figure 8.
Projects can create multiple instances depending on the required needs. An example would
be a public ticket instance for interacting with community members, and a private ticket
instance for developers only to track internal or cutting-edge development.

Tickets . New project
.
Code 3

Click to install

Wiki » & extemalLink <> Gt <> SVN wWiki 4 Tickets ¢ Discussion Blog ¢ Subproject
Another Project »
Discussion R Installed tools
Sortable - define top menu order by moving tools with your mouse.

Blog > Tickets for Support Tickets for Development Tickets for Documentation
Link Name > @ @ @
Metadata
Screenshots Field Management Field Management Field Management
CEETTIEAT Edit Searches Edit Searches Edit Searches
Tools

Permissions Permissions Permissions
User Permissions

Options Options Options
Audit Trail

Label Label Label

Delete Delete Delete

Figure 8: A project with three instances of the Tickets tool

Once installed, you can then select the tools for individual instances.

* Field Management
o Allows administrators to configure how the fields in the ticket tracker appear.

o There are several fields you can select from, that are most well suited for your
project needs.

+ Edit Searches

o |If you have a search that you want all users of the tracker to be able to share, you
can save that search with a name and it will be placed in the left navigation bar of
the tracker for everybody to use.
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°o You can use these saved searches to watch the flow of tickets through the system
and make it easier for your development team to focus on groups of active tickets.

* Permissions

o Allows you to define the permissions for viewing and resolving tickets.
* Options

o The default behavior of the Tickets tool can be modified here.

o Allows for voting tickets up/down, email notifications, and setting up customized
help texts.

Label and Delete options name and delete the instance respectively.

2.4.2.Using tickets

With the appropriate permissions, the user/you can create a new ticket using the Create
Ticket link in the left sidebar. At the new ticket form, fill in a title, any appropriate fields, and
an issue description. To edit the main ticket description or fields on an existing ticket,
providing you have the permissions to do so, select the EDIT button in the upper right of a
ticket. If further discussion about a ticket is needed, use the comment field at the bottom.

You can also move and delete tickets. This again depends on your permissions on the
particular instance. To move a ticket, select the Move option in the upper right of the ticket
view. To delete a ticket, select the Trash Can icon in the upper right of the ticket view. This
ticket will now be "deleted", however it may still be "undeleted" if you select the + icon which
replaces the Trash Can icon. If a deleted ticket matches a list view, there will be a "Show
deleted tickets" link which will allow you to see them.

Searching a ticket is also possible. The search uses Solr Lucene query syntax. On any
search page you see a Help button that will show the different searches available and some
exact examples.

With tickets you have plenty of options to adjust, search, edit, and work with. For full list of
features consult the platform user guide.
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2.5. Communication Tools

. Communication is key for the engagement between users and
Communicate projects. The platform allows users to interact through several
Engagement between users | Methods of communication. Here we introduce three:

and projects:

Wiki, Forum and Blog . The Wiki
. The Forum

Wiki > . The Blog
Tickets >

| Discussion Following the instructions here you can quickly setup your

: _ communication tools. To get the full benefit of the tools, learn

Git e more from the platform electronic guides available under
Admin " Documentation at the http://opensourceprojects.eu website.
Documentation >

g2 Create Topic

¥ Add Forum
General Discussion 2

OSP Development i

Formatting Help

2.5.1.Wiki

The wiki is a collaborative document editor which is easily edited and can be used for various
documentation needs, both internal and external. By default any project developer can edit
the project wiki, but permissions can be regulated as you wish them to be available to
different user groups. Like most modern wikis, all edits are non-destructive and a copy of
every version is stored.

2.5.1.1. Configuring the Wiki
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The wiki can be installed through the standard tool process highlighted in Section , the step
summary is the following:

Projects > ProjectName > Admin > Tools > Wiki

Once installed, there are a number of configuration options available for each wiki. In addition
to the common tool options of permissions, Label and Delete, there are also these options
specific to the Wiki tool:

Set Home defines which page the wiki will redirect to when the base URL is used. By default,
this is set to "Home".

Options page in admin provides you with the ability to add or remove three different pieces of
the wiki functionality.

* Show discussion aka the comments section on each wiki page

» Show left bar - Links to page creation, browse pages/labels, and formatting
help. All these pages will still be available if this is disabled, but you may need to
use direct links.

+ Show metadata - The author, label, and attachment display near the top of
each page.

If you want to maximize the screen real estate of the wiki, you may want to remove all three of
these options.

2.5.1.2. Using the wiki

Wiki content itself, like the rest of Allura tools, uses Markdown formatting, along with some
additional handling for Artifact Links and some custom macros. An example of a default Wiki
page is shown in Figure 9, which presents a page view and the available shortcuts, explained
below.
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Admin , New project

Home o
Tickets 2> L H anQ
Code » 1

Welcome to your wikil

P assion ? This is the default page, edit it as you see fit. To add a new page simply reference it within brackets, e.g.:
Blog > The wiki uses syntax.
Link Name

Create Page

Browse Pages

EBrowse Labels
Formatting Help L
Andreia

Palma

Q Preview Formatting Help

Post | Cancel Add attachment

Figure 9: A wiki page with Edit, History, Subscribe, Feed and Search

2.5.1.3. Creating and Editing Pages

Creating a page can be done a few different ways, assuming you have the appropriate
permissions:
* From the left sidebar, select Create Page and enter the desired name.

* On an existing page, create a reference to a new page by putting the new page
name in brackets (e.g. [New page]), then click on that link.

* Enter the URL where you want the page to reside, if it does not already exist
you'll be presented with an edit link.

To edit an existing page, simply use the pencil icon of Edit link in the upper right of a page.

To add an attachment to a page, first save the page content, as you may lose unsaved
changes otherwise. Select Add attachment button at the bottom of the edit view.
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Wiki pages may also be created and edited using the Allura API.

2.5.1.4. Moving pages

To move a page, first enter the edit view presented in Figure 10, and then change the name of
the page. Moving a page in this way will preserve the wiki page history.

Tickets New project N

) Edit wikipage Q¥
Admin
Code Name:

Content:
Discussion . .
Q, Preview Formatting Help

Blog

. Wikipage content.
Link Name HEIPEE

© Create Page
Wiki Home
Pages

Browse Pages

Browse Labels
Help
Formatting Help

Figure 10: Editing a wiki page

2.5.1.5. Deleting pages

To delete a page, enter the edit view as shown above, and then select the Trash icon in the
upper right. Deleting a page will remove it from view, however the page may still be undeleted
if necessary. To do so, select the + icon when viewing the deleted page. You will then enter
the edit view and you may rename the page as appropriate.

Deleted pages can be found under the Browse Pages view by selecting the Show deleted
pages link at the bottom of the list.
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2.5.2.Forum

Discussion forums are a way to collaborate with other developers on the project, but they can
also be used to discuss with end users. A project administrator can create as many different
forums as needed by clicking on Add Forum on the left sidebar of the discussion page. To do
so you must have activated the discussion module under tools. It is up to the administrator to
create and name as many forums as required by the project work flow. You can create as
flexible environment as you wish.

The Figure 11 shows the fields you need to fill to create a New Discussion.

o Blebon

3 Discussion Admin Forums
Tickets 2>

Code ]
Forum Topics Posts Last Post
Wiki ? .
General Discussion
Discussion >
general
Blog )

Link Name » — No monitoring email set.

H 3 3 by Andreia Palma 6 days ago | Delete
o Viewable by anyone

Screenshots
Anonymous posting not allowed
Categorization

Toals Forum about anything you want to talk about.

User Permissions
Name:

Audit Trail

Short Name:

Parent Forum:

None v

Description:

Figure 11: Add another forum page

Most of the fields are standard fields. Those worth to note are as follows:

* Short Name is the short name that forms the URL this forum uses.
* Parent Forum selects a parent if the forum is to be a sub forum of another one.
* Monitoring Email defines the email address notifications should be sent to.
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The Developer Only option can be used to set a forum to be viewable by developers only,
even if most forums are publicly available.

You may install or remove a Discussion via Admin > Tools. Once installed, there are a number
of configuration options available for each Discussion instance.

From the Options page you can edit the Posting Policy of the forum. It determines how
moderated posts are handled.

2.5.2.1. Using Forums

Beyond the standard configuration of the tool on the admin interface, you should get
familiarized with the forum process from the user's perspective. Here we go through the basic
use of forums: creating, posting and replying to threads.

You can create a new thread using the “+ Create Topic” link on the left sidebar of the
interface. This is shown in Figure 12. Enter an appropriate Subject, Forum, and then enter a
Description and post, an example of this form can be seen in the following figure.

29/35



PROSE D3.1: FLOSS Developer Handbook

Admin , New project

Create Topic
Tickets 2>

Code >
Wiki 3 Subject:

o q First topic
Discussion p

I

?
Blog Forum:

Link Name ’ General Discussion v

@ Create Topic

#® Add Forum Description:
| Forums | Q Preview Formatting Help
General Discussion 3

First topic description.

Formatting Help

Post | Cancel

Figure 12: Creating new topic

To reply to an existing thread you should be viewing the thread. Select “reply” next to a
comment to reply to that specific comment, or use the dialogue box at the bottom of the
discussion to add your comment to the end.

2.5.2.2. Moderation menu

With appropriate permissions, forum moderators have options to edit the forum. These can be
accessed using the pencil icon in the upper right corner. Moderators can move threads, make
announcements, and sticky posts.

2.5.3.Blog

The blog tool can be used for providing news about your projects. Examples include release
notes and change logs, announcing events related to your project, and so on. Nowadays
blogs are very important communication streams, as they provide a way of keeping up-to-date
with project specific news and provide a direct communication channel to the target audience.

2.5.3.1. Configuring the Blog
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The blog may be installed through the tools menu, as described before, by adding the
corresponding tool in the administration area via Admin > Tools. Once installed, there are a
number of configuration options available for each Blog. In addition to the common tool
options of permissions, Label and Delete, you can determine an external feed. These
external feeds may be updated every three hours and add posts to the blog accordingly.
Multiple feeds may be added, which can serve to aggregate related news about the project.
Unchecking a feed will remove it from the list.

2.5.3.2. Using the Blog

Like all Allura tools, the blog uses Markdown syntax. Each blog post will also have a
discussion section for users to comment on the post.

To create a new post, select "New Post" from the left sidebar under the Blog option. This will
result in the screen shown in Figure 13. Enter a title and description for the post and Save to
publish the post. If you save a draft for later editing before making it public, change the State
to Draft before saving. Select the Edit link to edit a post or saved draft. You may also delete a
post from the Edit view.

Admin d New project

X New project/Blog: New Post
Tickets

Code

Title:

Wiki > MNew post
Discussion >
Blog >

Link Name

Q, Preview Formatting Help
New post content.

Home
Search

New Post

State:

Published v

Labels:
Save | Cancel

Figure 13: New post on blog
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Note: The URL will be based on the original post date and title, and will not be
updated if you change the contents of the post.

2.6. Statistics and Metrics

The platform already provides some support for statistics collection and display. Even though
limited, there are a few available options to projects. The platform team will work on adding
more pending customer requests and consultations.

The important issue to start with is to deal with in platform ticket statistics, and with external
collection through Google analytics support. As the project grows in terms of in-platform
statistics collection, more content will be added to the platform user manual.

2.6.1.Ticket statistics

Ticket statics are collected automatically by the platform, and presented to the users with
permissions to view them.

Projects > ProjectName > Tickets > View Statistics

In order to check collected statistics for tickets, it is necessary to follow the summary
instructions: Once on the tickets page, select menu option for View Statistics, and the user
will be directed to a page similar to the one presented in Figure 14.
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Admin >
Tickets 2>
Code >
Wiki >
Discussion >
Blog >
Link Name >

& Create Ticket
:= Edit Milestones

&) View Statistics

1.0 o
2.0 o
Changes 0
Closed Tickets o
Open Tickets 0

Formatting Help

New project
Tickets / View Statistics
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#tickets: 0

# open tickets: 0

# closed tickets: 0

# new tickets in the last...

+ 7Tdays: 0

+ 14 days: 0

+ 30 days: 0

# of comments on tickets: 0

# of new comments on tickets in last...

¢ 7days: 0
* 14 days: 0
+ 30 days: 0

Figure 14: Statistics of a project

This shows the most basic statistics for you to start analyzing your project's activity and
healthiness regarding open and closed tickets.
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2.6.2.Google Analytics

Google Analytics is a Google's service to track detailed statistics that you can use to monitor
the activity of your project’s site. To be able to use Google Analytics, it is necessary to fill in
the tracking ID in project's metadata form. The metadata form can be reached through the
following:

Projects > ProjectName > Admin > Metadata > Analytics Tracking ID

Once on the metadata form, where several links can be inserted to complement the platform,
it is only necessary to provide the Tracking ID on the corresponding field form, which is
provided by the Google Analytics service on their web page.

Support Page:
* None

URL:
Twitter Handle

Facebook page

Analytics Tracking ID

Figure 15: Google Analytics Tracking ID
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3. Conclusions

This document provides an overview of the basic steps on what is needed to run and manage
a project and a dynamic community with the PROSE platform. Part of the strategy for this
document was to convert the original platform User Guide titled D2.2 Platform Handbook,
available at www.ict-prose.eu into a format that is usable by users that need to get familiar
with the platform. To achieve this the most common tasks in the platform were identified, while
focusing on streamlining and revising the available documentation.

Part of the work was not only transferring and adapting the contents of the platform
handbook, but also making them available online on the opensourceprojects.eu platform.
Accordingly, the project underwent the effort of converting the handbook to a Documentation
section of the platform at http://docs.opensourceprojects.eul/.

The next step for Task 3.1 will be to convert the proposed documentation into an additional
project document — entitled H3.1 — that will provide a summary of the information contained in
D3.1 (in both this deliverable and on the online platform). This will complete the major
documentation items for the platform composed by the overall handbook (D2.2), this
deliverable (D3.1), the online platform documentation (docs.opensourprojects.eu) and the
final printable handbook (H3.1) that can be distributed both digitally and in a printed format.

35/35



	Executive Summary
	Table of Contents
	List of Figures
	Acronyms
	1. Introduction
	2. Developer Handbook for PROSE Platform
	2.1. Setting up an account
	2.2. User Management
	2.2.1. User Settings
	2.2.2. Admin
	2.2.3. Wiki
	2.2.4. Creating a project
	2.2.5. Creating a sub-project
	2.2.6. Adding users to the project

	2.3. Code management
	2.3.1. GIT
	2.3.1.1. Using the GIT repository

	2.3.2. SVN
	2.3.2.1. Management


	2.4. Issue management – Tickets
	2.4.1. Ticket - tool
	2.4.2. Using tickets

	2.5. Communication Tools
	2.5.1. Wiki
	2.5.1.1. Configuring the Wiki
	2.5.1.2. Using the wiki
	2.5.1.3. Creating and Editing Pages
	2.5.1.4. Moving pages
	2.5.1.5. Deleting pages

	2.5.2. Forum
	2.5.2.1. Using Forums
	2.5.2.2. Moderation menu

	2.5.3. Blog
	2.5.3.1. Configuring the Blog
	2.5.3.2. Using the Blog


	2.6. Statistics and Metrics
	2.6.1. Ticket statistics
	2.6.2. Google Analytics


	3. Conclusions

